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Hello, this is Eric Bobrow, and in this lesson, we'll be taking a look at basic roof construction. I've
switched back to ArchiCAD 14 to demonstrate how roofs are constructed in ArchiCAD 10 through 14;
and then I'll go back to ArchiCAD 15 to take a look at the new methods that we use in the latest version.
[0:24]

So, here we have the first floor of the project that we've been working on. And I'm going to get ready to
draw some walls off to the side to use for constructing roofs in a variety of different approaches. So in
order to do that, I'll use the eyedropper. So I'll click on the eyedropper in the toolbar, and then go to
the exterior wall here. Now you'll notice that when | position over the edge of the wall that it's actually
picking up the slab. So | have two ways that | can pick up the wall settings. One is | can go to the inside
face of the wall, where it isn't sharing an edge with anything else, and it would then work. Or, if | go to
the outside edge here, you'll notice that in the preview, the little popup that says that I'm looking at a
slab, it mentions at the bottom multiple elements. It has the word "tab" indicated. [1:19]

Then I'll hit the tab key once, and even with the cursor remaining on the same position, it's now
prepared to pick up the settings of the wall that is there. So I'll go ahead and click. Now that tab option
will show up with the eyedropper or with the Arrow or Shift key, when you get the Arrow from just
pressing the Shift. So can control which element you select, either for actual selection or for using the
eyedropper. [1:50]

Now I'm going to use the scroll bar at the bottom here. We haven't used this too much, but I'm going to
use that a little bit just to get over to the side. It's a quick way to scroll over. You can see how I've got
the elevation marker off to the side, and I'm just going to move over past that. So now I've got some
clear space. Now with the Wall tool active, I'm going to draw a box of walls. You see how we have
single wall, poly wall, or a rectangular construction, and that's what I'll use. And I'll just start in the
general upper left area and start to draw this. Now, it's not too critical here, but | prefer to have
consistency where the outside edges of the walls are the reference line. So | will switch the construction
method from, in this case, right to left. And now you can see the outside edges are what I'm drawing.
[2:37]

And I'd like to make something a certain size. I'll type in 20 feet, and if you're in metric it would be 7,000
mm or 7 m. And then I'll hit the tab key and type in 30. And in metric that would be 10 m or 10,000 mm.
So that's a box of four walls. We'll switch to the Arrow tool, and click above and to the left, and then go
down to the right; and that will select all four of these walls that I've just drawn. Now I'd like to create



several instances of this, so that | can practice creating roofs. So I'm going to right click in empty space
where I'm not selecting anything, and you'll see the Move menu is available. Let me just repeat that. I'll
just click outside and repeat it up a little higher where you'll be able to see the submenu on your screen.
[3:25]

So when | go to the Move command, one of the options is "Multiply". | can also use Command+U" or
"CTRL+U" to get the same command. You can remember the second letter of multiply is "U". So when |
select that, you have the Multiply command which as many variations. Right now we're going to use the
one to drag multiple copies to a certain direction, rather than rotating or other options. I'll type in "6" to
say I'd like to make that number of copies. And we'll use the most basic drag and multiply option, which
is "Increment"”. And we'll return to this later to explain all of the other options. But right now, | just
simply want to incrementally draw one more, and have ArchiCAD create additional ones the same
distance away. [4:13]

So I'll just say OK. Now, you'll see in the status bar, "Enter Drag Reference Point", and it mentions that
we're dragging multiple copies. I'll go to the bottom left corner here, and as | move across, you can see
ghost images of the new elements that I'm going to be creating. Now the distance, I'm moving it
straight across, so I'm on the axis line, the snap guide there. And | can type in a distance let's say of 30
feet. So | just type in 30 or that would be 10,000 mm. So, you can see the first new one is showing, and
if  move over to the right, you'll see some additional ones. I'll just scroll back to where I'm looking at
the very first batch, because I'm going to start by drawing a roof on top of these walls. [4:59]

So I'll go activate the Roof tool. Now we're in ArchiCAD 14, and these settings would be the same of
ArchiCAD 10, 11, 12, 13, and 14, as well as the Start Editions that would correspond. And I'm going to
create a single roof in a rectangular form. So you'll notice that | select the geometry method that's a
rectangular creation. Now is says, "Enter First Node of Roof Pivot Line". So the Pivot Line is often the
plate line of the roof. Whether it's the plate line or not, it's a line in space that's horizontal, and then the
roof pitches up or down from that in a constant angle. Now, I'm going to go to the left side of this
building, get a checkmark in the upper left corner, and go down to the bottom left corner. When | have
the black pencil, I'll click, that defines the pivot line. [5:50]

The next click ArchiCAD is waiting for me to click on: the upward slope direction of the roof. So we get
the eyeball cursor, similar to when we were placing in doors and windows. And I'll just click anywhere in
the body of the building and just say | want to go up this way. Now, it's holding now a pencil as
indicated, and | can draw by clicking on one corner of the building and going diagonally down to the
other corner. And when | get a black pencil, | know I'm cleanly on that edge. And when | click again,
we'll see that it is completed drawing the roof. There's not much to see here, in terms of new things
onscreen. There's a little thing called a tick mark, or at least | call it a tick mark, which is the center of the
pivot line, the first line that | drew. [6:40]

And this will not print, but it does allow me to select the roof sometimes or to modify the roof settings.
Now let's take a look at what | drew in 3D. I'll go it’s the Marquee tool, and | will draw a marquee
around this. And |think it's a good idea, in this case, to have it with the heavy marquee so that in case



there are things on multiple stories as we're working, were set up to view them. Now, having drawn the
marquee around just this batch of elements, | can right click in empty space and choose "Show selection
or marquee in 3D". On the Mac, we're seeing right now the shortcut is F4. If you're in Windows, it's
probably F5. | don't quite know why it's different on the two platforms, but just use the right click
method to select it. And if you want, you can use in the future the command that you see there. [7:35]

Now if you're on a Mac, and you're finding that hitting the F keys doesn't work immediately, you may
find that holding down the "Fn" or Function key in the bottom left of your keyboard, and then typing the
F key in the top, that it works. There's another way that you can reset the preference, but for now, just
remember or try that if just hitting F4 by itself doesn't do it. So I'll just select this, and you can see, oh,
that's a rather steep slope. Let me rotate or orbit around it. I'll use the Orbit mode here. And you can
see, oh that's a rather steep slope. So let me select with the Arrow tool. So | just switch to the Arrow
tool. And I'm selecting the roof, and I'm going to change this, oh it says 45°. Let's change that to 20°.
And you can see it's much lower. [8:26]

Now roof slopes can be chosen, in addition to degrees, if you open up the roof settings dialog. Either
before you create roofs or after, you'll see that there's an option here to set it by degrees, percent, or
rise over run. In the U.S. it would be in 12 feet. So for example, in the U.S., we might want to say that
this roof is a 4 and 12 slope. Now in ArchiCAD 15, actually this option shows up in the info box as well as
in the roof selection settings. [9:01]

So I've set it up to a 4 and 12 slope, and | have the roof settings to be at 9 feet, which would be about 3
m, which as you can see matches on the left side. You can see how it matches the height of the walls.
And I'll click the OK button. So I've just adjusted it slightly. Now how do we make these walls trim to
the roof or join to the roof? In ArchiCAD 10 through 14, here's the process. I'm going to go and select
all of these walls. | could select them one by one, but I'll use a shortcut. I'll activate the Wall tool and go
to the Edit menu and say, "Select all Walls", or use Command or CTRL A. [9:41]

Now it's only going to select the walls that are in this particular 3D model. In other words, | selected just
to look at that one little area, so it's not going to affect anything that isn't in that area. Now it selected
all of them, and you can see they're all highlighted. And you can see that in the info box, is says
"Selected: 4", and they're all editable. Let me just change the height from 9 feet up to 20 feet, that
certainly more than we need. But for now, let's just leave it at that. [10:12]

Now having raised them up high enough, | can use an option under the Design menu that has been
around since ArchiCAD's beginnings, and that is "Trim to Roof". Now in ArchiCAD 15, this has changed
to "Crop to Roof" or something similar, I'll show you that later. But Trim to Roof is a very quick way to
just trim the top or possibly the bottom, because you could use this for let's say, a dormer, where you
have walls on top of the roof. But normally, most commonly you trim the top, and there are some other
options here, but let's go ahead and trim. [10:47]

And you see very quickly how it works. | just clicked an empty space to deselect these walls, just to
show you how it looks. And now I'm going to go to the Roof tool, and I'll show you one of the limitations
of this. If | select the roof by clicking on it with the Arrow tool, and let's just change its slope down to



12° or something like that. You'll notice that the roof got shallower, but the walls didn't adjust. Now |
can go ahead and select all these walls, I'll go the Wall tool, select all walls, and | will then use the
command here, "Trim To Roof" again, and now they're adjusted. [11:27]

So, it works pretty well. However, if | select this roof and we take it up higher, let's say 20° or something
like that, then the walls won't work that way. Because if | select all the walls, and do the again the same
"Trim to Roof", nothing happens, because they've already been trimmed down too much. Soit's not a
huge problem, but you will need to go into the Wall Settings Dialog and use the option under the Model
Panel, where you might change materials, to undo the roof trim. And then, my OK button right now is
below your screen recording, but I'll just click OK, and you can see now they're raised up. [12:15]

And | can use a keyboard shortcut, Command+0 (zero) or CTRL+0 (zero) to do the Trim to Roof, and it's
pretty quick work. But there is a superior option here, and I'll just undo the last trim to show that to
you. This is using the Design menu command called "Solid Element Operations." And this is a little bit of
the mouthful the first few times you see it or read it. Usually you will see the palette open up with all of
these things. I'll close down the bottom area of "Maintain Operations", because all we need a see is the
new operation. [12:52]

So, what is Solid Element Operations? We'll look at just one example of this right now, and that we're
going to use just to make sure the walls and roof stay connected. And this is approaching a slightly
different way in ArchiCAD 15, but the principles are actually quite similar. So even if you're on 15, pay
attention. Now, these walls are going to be the target. And by the way, they are solid elements. And
this particular tool will only work when we're using solid elements, as opposed to something that might
just be a plane that has no thickness. So there are occasionally times we might create something in
ArchiCAD that can't use this, because they have no solidity. [13:39]

Now I'm going to deselect these walls by clicking in empty space, and I'll use the Shift+click to select the
roof. Holding down the shift key when no operation is in process will activate the Arrow tool
temporarily. It's a great way to be able to select things right on the fly without having to go up to the
toolbox. So I've now selected the roof, and I'm going to make it the operator. So it's going to operate
on the walls which are its target. Now what is it going to do? It's going to subtract out its space where it
exists and everything above it. So I'll use the "Subtraction with Upwards Extrusion", and then click
"Execute". And you can see, ah that works very nicely. [14:22]

Now what happens if | change the roof slope? So I'll Shift+click to select the roof again, and this time I'll
change the slope down to 12°. And you can see, oh, it instantly worked. We didn't have to re-trim the
walls. Or I'll take it up to 16° or any angle that we like. Now, if | do take it up to 45° or something that's
really steep, you'll notice that the walls are only partially trimmed, because in fact they're not tall
enough. So in some cases we may need to go in and adjust that. If | go to the Wall tool, select all walls,
and take them to the new height. Now, | can adjust heights of elements by selecting them and changing
them in the info box, like here. But | can also go to usually a corner, top or bottom, press down, and
when the pet palette comes up there's often an option to change the height. [15:21]



Right now, you can see the image of a wall or something rectangular getting taller. And I'll just use that.
And you can see my ghost image, its showing what it's doing. And | can move it around, | can type into
the tracker. Right now it's set to 27 feet or 9 m or so. Or | can just actually snap it to this element here.
And you see how beautifully that worked. | didn't even have to type in anything. | simply said, "I'd like
to make them taller." Now, of course, | think that's a little bit steep for what | want, so I'll just take the
roof slope down to 20°, or you can try whatever you like. So we'll do one other thing with this simple
roof. | just hit F2 to go back to the floor plan. I'm going to go select this roof. [16:10]

Now when | select the roof, if | hold down the Shift key, you'll notice that it's going to select the walls.
Why is that? Because the Wall tool is active right now in the toolbar. Now if | switch to the Roof tool,
and | hold down the Shift key, then when | go to the edge, you'll notice that it's highlighting the roof and
allows me to select the roof. So if you would like to select something, it's often a great way, when it's on
top of something else, it's often a great way to select it by beforehand changing to that tool. And
ArchiCAD will show you, or prefer to select tools of that type or elements of that type. [16:53]

Now I'm going to go to the corner of this and press down. And you can see the pet palette or Editing
palette comes up. And we have a number of options for dragging and rotating in doing things as a
whole, to the element in the lower part. And then we have options for editing parts of the element, or
modifying its shape in the upper row. And I'll go and select the one that's, in this case, third from left,
which is "Edit the polygon outline by offsetting it uniformly bigger or smaller". So when | use that offset
option, you can see that as | move around, it's proposing making it bigger or smaller. And I'll just type in
a distance of 1 foot or 300 mm, to just give it a bit of an overhang. And I'll click outside to deselect, so
that when | go back with the option to show selection marquee in 3D, we're seeing the walls and the
roof. [17:48]

So now we've got this with an overhang. So, we've done a bunch of operations just on simple shed roof.
Let's move on a little bit and try doing something with a gable roof. So I've slid over with the scroll bar,
I'm going to hit the Esc key to turn off the marquee. And with the roof tool active, I'll again draw a
rectangle of a roof. But this time, I'll only draw it halfway. So I'll click on the left edge, click on the roof
to say that it's going up here, and then I'll click on the top left corner. And when | get down here, I'll
look for the tick mark that says I'm at the halfway point. Now remember that these special snaps could
be snapping to distance or something else other than halfway. [18:37]

If you need to, you can adjust that right here in the Special Snap Palette. Right now it is set to half, so
that's perfect. So I'll just go along until | find that little tick mark, and | get a black pencil. And I've now
drawn a half of the roof. And I'll repeat the operation. I'll just draw the right edge as the pivot line, click
in the body of the building to say | want to go up that way, and then I'll draw the rectangle neatly
snapping to that. And we'll use the marquee to say | want to just look at this particular area in 3D. So |
outlined it and I'll go, "Show selection marquee in 3D", and it's over a little bit in space. Let's just Fitin
Window, and you can see, yes, it actually made very nice, clean intersection between these roofs.
[19:34]



Now, I'm going to go and show you how you can make these walls join to the roof. It's very similar to
what we had before. I'll use the Arrow tool to select say this front wall. And then I'll go to the top here
and use the option to stretch it up. | could also just type in a value. I'll take it up to the top of the roof,
and then | can use either the Trim to Roof, which is very quick work, or if | undo that, | can use the Solid
Element Operations and say this is the target, and then click outside it. In this case, I'm going to need to
select both the left roof can Shift+click on the right roof so now they're both selected, and make them
operators, and execute. And that's going to work beautifully for making a gable situation. [20:27]

Now | haven't done the other end, I'll just leave that to you to do if you'd like. Now I'll go back to the
floor plan with the F2 key, and let's just look at how we overhang, or create overhangs for these roofs.
So in order to select the roof, one way we can do it is to actually go to the tick mark for the roof. That's
a way to select it. And | can go, and if | want to make an overhand, let's say on just the edge of the roof
that is low, | can use, instead of the option for changing all sides, | can say just this one side. Now these
editing operations are the same that we have learned for the slab, so all polygon elements have very
similar options for editing their shape. [21:13]

And I'll just take it out one foot or 300 mm. And I'll go to the bottom edge and take this down, oh, let's
say 6 inches. That would be 150 mm, so maybe make it a little bit tighter. So | can go along to each one
of these edges and turn and use the same option. But oops, | did the wrong one. |said 150, and I'm in of
course the U.S. version so | need to type in 6 inches rather than 150, because it went out 150 feet |
imagine. Now, one little trick here is once you've got the shape, if you don't want to repeat it all on the
other side, you can select the roof on the other side, let's say. I'll just select it by clicking in the middle
area with the magnet quick select. [22:03]

This option here | can actually select in the body of the roof, rather than having to go to the edge. I'll
delete it by hitting the Delete key or the Backspace key, and then I'll select this roof that I've just
adjusted carefully, right click somewhere in it, and in the Move menu, we'll do "Mirror a Copy". Which
you may recall from the previous lesson, | mirrored a window and a wall to make a new copy. Now I'm
going to mirror this roof over the ridge line. So here I'm going to click anywhere along this ridge line,
and you can see that as | move, it's about to prepare a mirror image, but | have to do the second click to
say it's along the ridge line. [22:42]

So now I've perhaps made it a little bit quicker, having edited one carefully, and now | can go back, hit F4
or F5, and you can see what's happened here. Now, because the other roof was doing the trimming,
and it's been forgotten, we have this little issue, but | can simply go and select the wall again, make it a
target, select the roof here, make it an operator, and again, subtract it. Remember it's the same,
"Subtraction with Upwards Extrusion", and we're done right there. So we've now created a gable
situation. Now let's do this again, and let's take the gable or the roof, and we'll create it on one side.
[23:36]

And this time I'm going to create it just partway. In other words, I'm not going to draw all the way. And
I'll do another one on the other side, again just partway. The reason I'm going to do this is I'm going to
show you a shortcut for making roofs intersect. Now this is very critical in ArchiCAD 10 through 14. It's



less necessary in ArchiCAD 15, because more often were going to use what's called the "Poly roof
Construction" or the "Multiple Plane Construction" that handles a lot of this automatically. Now with
the Marquee tool, I'll just draw a new marquee around this area, so that we can visualize this in 3D. So
I'll go to 3D by hitting F4 or F5, and we now see the two roofs. [24:29]

Now I'm going to select one of them by Shift+clicking on it, and now I'm going to hold down the, if
you're on the Mac it would be the Command or Apple key, and if you're on Windows it would be the
CTRL key. So I'll hold that down and | go to the edge of the other roof. In this case, the top edge surface
that will adjust itself to become the ridge line. So I'm going to an edge that will be able to adjust to
meet the other roof, and | Command or CTRL click. And you see how it's adjusted in space. Then I click
outside it, and Shift+click or Arrow+click on this roof on the right to be the controlling roof. And then
Command or CTRL+click on the edge of the other one. You see the Mercedes in the preview or the
cursor change. [25:21]

And when | click, it's now connected it. So this is another way you can do it, one reason why it's very
important to learn this is that it works in a variety of context, not just a symmetrical one. Let me just
undo back a few steps, and let's say that we take this left hand roof and we change its slope. So |
Shift+clicked on it, and I'm going to take it down to 10°. So it will be a much shallower slope here. And
so now, I'm going to go and with that selected, Command-+click or CTRL+click on the edge of the other
roof. And you notice how the other roof shortened itself, because it's going to actually only go up a little
ways, while the other roof will require more run to be able to meet it. [26:06]]

So now | select the right hand roof, and Command or CTRL+click on the top of the other one. And you
can see the shape that's been created. Now of course | can raise the wall up and trim it underneath as a
gable, but we've already done that, so | won't repeat that exercise. And we could do overhangs, the
same process would apply. But mainly, | wanted to show you that you can have any angle of roof meet
any other angle, as long as you follow that basic process. So that's the third example. Let's scroll over
and do the fourth one. [26:40]

So now, I'm going to go and I'll just draw the marquee around this new area. And now I'll switch to the
Roof tool. And I'll draw a new rectangular piece here. And in this case, just for speed, | will take it to the
halfway, and maybe I'll just select this one and right click. And again say, "Mirror a Copy" across the
edge. So now we've got two of them. You can see the tick marks on the left and on the right for those
two roofs. Now, I'm going to want to create a hip. Let's try it on the bottom first. I'll go and position
myself on this bottom corner here, which has to be pulled back to accommodate the other roof that's
going to be perpendicular. So I'll press down on it, and in the Editing palette, right now it's proposing or
remembering that | was doing an offset. [27:47]

But | want to switch to this option to just move this one node point. So when | activate that, you can see
I'm just moving the one node point. | don't know how far to take it back, | mean, if you drew a line at
45°, you could calculate it. But, I'm just going to pull it back a little further than | think it needs to be.
And then | will do the same on the other roof that is in here. So I'll click outside to deselect, Shift+click
on this left hand roof to select it, and press down on the corner. And it will remember that I'm editing



the corner, so I'm only moving nodes. So | usually don't even have to return to the pet palette, | just
proceed by moving that into a new position. [28:30]

So now, what | need to do - let's just take a look in 3D. So we'll take a look here at these elements, and
you can see that there's - we've got this roof with a gap. So let me go back to the floor plan. Actually,
let's just orbit around this so we can see a little more clearly what's going on. So there are two roofs
with a gap waiting for it to be filled in. So I'll go back to the floor plan by hitting F2, and then I'll go to
the Roof tool again, and this time I'll say that the pivot line is going to be at the bottom of this
rectangular group of walls, and that it goes up. But | need to switch it from rectangle mode to polygon
mode or polygonal mode, where I'm going to create any shape | want. [29:13]

So now, as | click, | can click on these two points and then a third point. I'll just do it arbitrarily, just
somewhere in the middle here, and I'm deliberately doing it off angle just so you can see that it doesn't
really matter that it's precise at first. Because what we're going to do is ask ArchiCAD to reposition the
edges to meet each other, so that each of these roofs meet. Now if | go to 3D right now, we'll see that
that piece is just sort of sitting in there waiting, and there's a gap. And we need for it to be adjusted.
Now, sometimes it's fun to do this right here in 3D, we can use that Command+click or CTRL+click
method in floor plan, but I'll just do it in 3D. I'll select the lower roof as the controlling roof. Whatever
you select is going to control the action, and then I'm going to Command+click on the top edge of this
other roof here, and it adjusted slightly. And then I'll Command+click on the top edge of this left hand
roof, and you can see that they've both adjusted. [30:18]

Now, | could move this top corner point right to there. It would work perfectly. But let me show you
that we can also go and select, let's say the top roof here, and go to this edge, the edge that's going to
reposition, and Command or CTRL+click, and it will readjust. So now it's right in line, but of course this
other edge needs to be adjusted. So I'll select the left hand roof here, and Command or CTRL+click of
this. Now you have to go to the edge, not the corner, you have to always Command or CTRL+click on
the edge. You can see how it's made a beautiful, clean intersection. And when | go back to the floor plan
it looks just like what you would expect for a hip. Now | will leave it to you to repeat this process on the
back end, and we'll move on to the next example. [31:06]

I'll draw a marquee around this one so we can visualize it. And in this case, I'm going to use a different
method for creating the roof. Instead of creating a single rectangular piece or polygonal piece, polygon
piece, I'm going to use the Poly roof method. Now this is the most similar to what ArchiCAD 15 has, and
we're going to be seeing that when | repeat the process in 15. Now, I'm going to go click of a series of
points, and basically these are the outlines of the wall. So I'll go on all four points and click. And now,
before it draws the roof, it brings up a dialog box that's called "Poly Roof Settings". And so, this is
saying, "How many levels do want?" Right now, we're just doing one. [32:01]

You could do a rather complex shape, it might create a steeple effect or various other shapes that you
might do with multiple planes. But right now we'll use the simple one. And again, it has the base
elevation, which we are matching to the height of our walls typically. So that's 9 feet or 3 m. And it has a
slope, whatever you want this to be. | will have this at 5 and 12, and overhang, I'll say 1 foot but or 300



mm. And then there's also roof thickness that you can specify here. So there's a variety of different
controls. The outside edges here, as they overhang can be vertical or plumb, or they can be
perpendicular, or they can be horizontal. Or they can actually can be adjusted later as well. But for now,
we'll use the one that says vertical. And I'll say OK. [32:54]

And you can see how instantly, it's created the shape with a hip on both sides. And when we look in 3D,
we'll see that this is exactly what you might expect. I'll orbit around here so we can see how that looks.
Now, we'll want to try one more variation here, and that is to use the marquee over here, and we'll go
back to the Roof tool. And we may have to double check that it's in the Poly roof method. And in this
case, I'm going to go and use the magic wand. And | don't know whether we've used the magic wand
much in the course so far, to activate the magic wand, you can hold down the space bar. SoI'mina
Drawing tool, in this case the Roof tool, I'm going to hold down the space bar, and that will create the
magic wand. | believe it's also available under the Design menu, Outlined Polygon with Magic Wand.
[34:05]

At least in some versions of ArchiCAD, that is available as a command. In either case, we get the magic
wand, holding down the space bar or using that command, and then we can click on the edge of this
group of four walls. Again, the same settings dialog comes up, and we're done. Now, sometimes that
won't work if those walls aren't cleanly intersecting in a way that ArchiCAD can interpret, so you may
have to trace them manually. But it can be a real timesaver of course. [34:35]

Now what happens if we are using this, and we want to create a gable at one end? This may be a very
complicated shape, and it may create hips everywhere, and we'd like to create a gable, what can you
do? Well let's take a look in 3D, so I'll hit F4 or F5, and go and take a look. Let me go and hold down the
Shift key to get the Arrow, click on this lower hip, and select it. And then hit the Delete or Backspace key.
And you can see how that has just disappeared. Now, as an expert, | could go and edit this in 3D and get
a great result, but it's a little easier to do this in 2D. So I'll return to the floor plan. So I'm going to go
and select one of these roofs that now need to be adjusted, go to this corner point here, and just like
earlier, I'm going to use the "Move Node". So I'm only moving the one node, not all of them. [35:29]

So in the pet palette, that's the choice. And I'll just take this down. Now, when | take it down, I'd like it
to line up with this point on the left. So in ArchiCAD 10 through 14, you'll see the blue line show up, and
you can just move across that blue line without clicking, and it becomes an orange line. If you're in
ArchiCAD 15, you can press down on that corner point and hold the mouse button down while you drag
horizontally or vertically, whichever way you want. And then you'll see the orange dashed line come up.
So in 10 through 14, it will automatically show the blue lines, and you just roll your mouse along without
clicking. In 15, you press down the mouse button, gesture in the direction you want, and then after you
see the orange lines, you can let go. [36:13]

Now you notice that I'm seeing a perpendicular snap here, so that's clearly going to be a nice clean snap.
Or, if I've been moving along this axis here, you may see sometimes an intersection snap, because we'd
be intersecting the vertical and horizontal lines. But in any event, one of those snaps should be there.
We can also read off the angle, it says 90°. And so we know that that's a very clean position. And then



I'll deselect this by clicking outside of everything, hold down the Shift key to select this right hand wall
that activates the Arrow tool and allows me to select it, and press down on this upper left corner, adjust
the node down, and when we get the black pencil it snaps, and then deselect it. Because when | go to 3D
with the marquee, | don't want anything selected, | want it to just show what is in the marquee. [37:12]

And when | go back, you can see we now have a neat gable. So, even if you do use the Automatic
Construction, you can remove pieces and adjust those roofs to suit your needs. So we'll go on with one
more example here. And now we'll go and actually adjust the shape of this building and make it a little
more complicated, to make more of a general case. Now, I'll go to the Arrow tool, and I'll select this
lower wall. And so I've just positioned over it and then clicked, and we get it highlighted. [37:47]

Now I'll go and press the bottom right corner, and when | press down, one of the options would be to
move the whole thing or to rotate it. But the last option here if I'm on the end of the reference line
where the hot spot was, is that I'd like to change its length or its endpoint. And as | move that around,
you can see the tracker allows me to see the angle, that I'm still on a nice horizontal 0° angle, and I'll
change the distance. It was 20 feet, I'll change it to 28 feet. You could, if you're in metric that would be
about 9 m. Not too critical, just something like that will work. [38:26]

Now, | want to draw a wall going up and then back, so in order to do that, if I'm going to need to switch
to the wall tool, so I'll click outside to deselect and get the eyedropper. So if | hold down the Option key
or the ALT key, that brings up the eyedropper. You can also go up to that icon in the toolbar that does
that. And having clicked on the wall, I'm now about to draw a new wall of the same type. Butit's
proposing that | draw a box of walls. Now remember, the preview image shows what it's going to do,
but you can tell it, "No, no, no, | don't want to do a box of walls, | want to do just one wall or perhaps
more than one wall but one at a time." [39:15]

So I'll do the Poly wall method. And I'll take that now along the snap guideline, and I'll take it up 12 feet
which would be about 4 m, big enough for a room let's say. And then I'll take it back to the left, and
when | get the perpendicular snap, and a nice clean angle and distance, I'll click. And then | can right
click and say OK, or | can just click again on that same point to finish those two walls. Now perhaps this
other wall here might be good interior wall, but I'd like to get rid of it for now, because maybe it's going
to be on a different layer. It will need to be a different wall type, or maybe it's not going to be in that
position. So | will use the Command or CTRL key, Command on Mac, CTRL on Windows, to get the
scissors; with nothing active that's what you'll see. [40:06]

And when | go to the edge of this wall with the scissors, it turns black, and then still holding down the
Command or CTRL key, | click, and it trims. So now I've got a shape just a little bit more complicated,
and a little bit more realistic, because most buildings are not a rectangle. Now I'll go to the Roof tool,
and again, pick the poly roof method, and then I'll use the magic wand, hold down the space bar, and |
get the magic wand. Go to the corner and click, and it brings up the same dialog box. Now sometimes
when I'm holding down the space bar, the levels had a one there, | need to type the 1 in again to make
sure that's OK, because it had replaced the one with a space. And it would probably not like that.
[40:54]



So I'll leave all these settings alone and say OK. You can see how instantly, it's created a more complex
shape. Let's take a look it that in 3D. I'll draw the marquee around here, and we'll take a look in 3D at
this. And no big surprise, by the way, if your solid element operations palette is in the way, you can just
close it using this red button here, or you can collapse it by perhaps closing one of the panels like the
New Operations panel. | like doing that because it's really easily at hand, but it doesn't take up much
space on screen. And if we just orbit around this, we'll just see, yes it's pretty much what you would
expect to see in certain types of roof construction here. [41:42]

So that concludes our demonstration for roof construction in ArchiCAD 14, which applies to ArchiCAD 10
through 14. In the next section will be taking a look at how this works in ArchiCAD 15. [41:59]



